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VSAM - Agenda
» VSAM — Today and Tomorrow

» Steve Branch, IBM Systems and Technology Group
= z/0OS Problem Determination Tools for VSAM

» Dan Brown, IBM System z Application Development Tools,
Americas

» CICS Tools for VSAM

» George Lees, IBM System z Application Development Tools,
Americas
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VSAM - History

= AM1
= Virtual Storage Access Method

= Access Method and a Data Set Type

= VSAM Components
— VSAM Record Management
— VSAM Open/Close/EOV
— ICF Catalog
— IDCAMS

= VSAM is a part of base z/0S

DEMAND BUSINESS'




| 1BM Software Group

Types of VSAM Data Sets

= The Original Three Types
—Entry Sequenced Data Set (ESDS)
—Key Sequenced Data Set (KSDS)
—Relative Record Data Set (RRDS)

'ON DEMAND BUSINESS



ESDS

| IBM Software Group

Simplest VSAM data set type
Records are in time written sequence

— definition: record - logical unit of data. It has
length.

Records have no keys

Records are variable length

Position of record in the data set is not important

An ESDS is similar to physical sequential data sets (PS)
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KSDS — Key Sequenced Data Set

= Primary access data set type

= Records kept in sequence by a unique key

= An index of keys is kept and points into the data
= The index is used to search for records directly
= Records can be accessed sequentially

= Records can be variable length

= Faster than sequential searches, slower than relative record
search, good performer nonetheless

Data

G7

GHI | T2

ABC
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RRDS — Relative Record Data Set

= Relative record position
= Allows fast access when key is the order number of the record
— Records must be fixed length.

— Records are located by multiplying the key by the record
length.

— RRDSs are rare in the real world.
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LDS — Linear Data Set

= Similar to ESDS

= No concept of records

* Processing by Control Interval (ClI)
= A Cl is like a block

= DB2 first user

' DEMAND BUSINESS'
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VRRDS — Variable Relative Record Data Set

= Behaves like a RRDS, really a KSDS by key

= No way to compute position of record
because records are variable length, so an
index is used

= Requirement from U.S. Government

MAND BUSINESS
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VSAM Data Sets

= Only reside on DASD

= Must be cataloged (except for temporary VSAM
datasets)

— Entry in the Catalog — Catalog record
— Entries in the VVDS - VVRs
— Entries in the VTOC - DSCBs

' DEMAND BUSINESS'
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Access Method Services (AMS)

= AKA - IDCAMS

= Purpose - Define, Delete, Alter, List, and Recover
data sets - especially VSAM data sets

= Manual - SC26-7394

* Invoked via JCL, TSO or can be called by an
Assembler program

MAND BUSINESS
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VSAM Alternate Index - AlX

= Provides a means to reference an ESDS by a key

= Provides a means to reference a KSDS by other than the
primary key

= Clusters pointed to by an AIX are called base clusters
= Allows duplicate keys

= An AlX is a KSDS itself — it has a data and an index
component

MAND BUSINESS
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VSAM Enhancements Through the Years

= Compression for KSDSs
= Striping — Data is spread across volumes

= Extended Addressability - allows for data sets
greater than 4 gigabytes

= Partial Release — releases unused space at the end
the data set

= System Managed Buffering — allows the system to
choose the buffering technique

MAND BUSINESS
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VSAM Record Level Sharing and Transactional VSAM

= Record Level Sharing (RLS)
— Allows record level sharing between Sysplex
— Done using the coupling facility

— provides locking, two-phase commit, and logging facilities in
an CICS online environment

= Transactional VSAM (TVS)

— provides locking, two-phase commit, and logging facilities in
a batch environment

— allows multiple batch update jobs to run concurrently with
CICS access to the same data sets while maintaining
integrity and recoverability

MAND BUSINESS
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Sources of additional information

= Manuals

— S§C26-7394 DFSMS Access Method Services for
Catalogs

— 8C26-7410 DFSMS: Using Data Sets

— SC26-7409 DFSMS: Managing Catalogs

— SC26-7408 DFSMS Macro Instructions for Data Sets
* Redbooks

— URL for VSAM Redbooks: wa3.itso.ibm.com/cgi-
bin/searchsite.cgi?query=vsam

— SG24-6105 VSAM Demystified
= Hot Topics
— URL: www.ibm.com/zseries/zos/hot_topics.html
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Summary

VSAM is both a set of data set types and an access method
that provides a rich assortment of options for your
application needs.

VSAM is tested technology with a long history of reliability
and performance.

z/0S customers depend upon VSAM for their business
needs.
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The End

If you have questions in the future,
please contact

Stephen Branch

branchs@us.ibm.com
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z/OS Problem Determination
and Deployment Tools For VSAM

Version 8

Dan Brown
£, {
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IBM’s Solution

= Offer a set of tools that:
» Exploits IBM'’s latest software and processor technology
» Offer wide array of key features and functions
» Can enhance the Application Development Lifecycle
» Provide opportunity for increased user productivity
» Are affordably priced
» Have flexible terms and conditions
» Have no license keys
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What is File Manager?

= |ntegrated suite of functions to help z/OS application
developers work with VSAM data across a wide
range of formats and storage media: browsing,
finding, editing, creating, copying, printing,
comparing, and erasing data

= |deal for creating and working with application test
data, or locating problems in application data files

= Functions can be accessed via interactive panels,
called in REXX or DFSORT procedures, and batch

jobs

'ON 'DEMAND BUSINESS
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File Manager for z/OS (FM)

=Key features New in FM V8.1
» Select, create, browse, copy, edit, print, and - Integration with Rational

format or reformat VSAM data files

Developer for System z
» Manipulate VSAM data using COBOL and PL/I

record layouts interactively or in batch. - Data scrambling support

» Gomprehensive, user-friendly, batch and - Load Module Compare

interactive utilities extends standard ISPF _ _

» Access CICS VSAM resources with CICS * File Manager edit and browse

transaction enhancements

» Audit logging and data scrambling for VSAM - File Manager DB2, IMS and
«|BM Product Support CICS enhancements

» Works with, CICS, DB2, IMS and z/OS (QSAM,
VSAM, PDS, HFS) data

» CICS TS V1 to V3, IMS V7 to V10, DB2 V7 to V9

|DEMAND BUSINESS
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File Manager for z/OS (FM)

PrObIem Process Options Help

File Manager Utility Functions

= You want to modernise and extend | couni o) o
your System z application

0 DBCS Set DBCS data format for print
= gy = 1 Create Create data
|nvent0ry but it’s taklng too Iong 2 Print Print data
- 3 Copy Copy data
to bring your new developers up to | « ostist Catalog services
. . 5 VTOC Work with V¥TOC
Speed Wlth the flles and databases 6 Find/Change Search for and change data
. 7 AFP Browse AFP data
they need to work Wlth 8 Storage Browse user storage
9 Printdsn Browse File Manager print data set
10 Loadlib View load module information
11 Compare Compare data
12 Audit trail Print audit trail report
13 Copybook View and Print

= File Manager identifies the Fi=Help F2=Split F3=Exit F4=CRetriev F7=Backward F8=Forward
structure of your VSAM records roTonap THOTRettons HiETtaneet
and displays and allows
manipulation of each field
according to its data type

= Promotes understanding and speeds the
development process

'ON DEMAND BUSINESS
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Advanced Functions

= Aimed at application developers:
» Format VSAM and QSAM data according to definitions
in a COBOL or PL1 copybook, displayed as either:
= A table, under field column headings
= A single record per panel, listing field values next to field names
» Select records with Boolean conditions
» Select fields

» Copy selected records and fields between data sets, and
insert/delete/reformat fields

» Create test data according to user-specific patterns

» Compare data between data sets according to user-specified
patterns

'ON 'DEMAND BUSINESS
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Highlights

Find and change data within specific fields

|dentify fields that contain invalid values

Use selection criteria and/or sampling to limit the number/type of
records in Browse/Edit

Edit entire VSAM file regardless of size

Copy or print selected records and fields
= Test data generation for VSAM based on record layouts
= Compare data between datasets using field level mapping

"DEMAND BUSINESS
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File Manager - Manage a variety of enterprise

data file structures

|

F|Ie File
Manager Manager
z/0S CICS

SPF/CICS
RDz

Do what you want,
how you want,
with your data

Common User
Interface In All
Environments

1 %
'ON DEMAND BUSINESS
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Full function edit and view

» Table

» Single

Flexible selection criteria

» Work with copybooks or templates
Edit any file regardless of size
Create data

Print data

Copy data

» File reformatting
» Scramble fields
Catalog services

Work with VTOC

Compare
» Data
» Load Modules

Search for and change data

» Insert continuation JCL
statement

View or print
» Copybooks
» Templates

Modes Of Operation
» Interactive

» Batch

Interfaces

» ISPF

» CICS

» RDz

'ON DEMAND BUSINESS'
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File Manager Primary Option Menu

Process Options Help

File Manager
Command ===> 2

Primary Option Menu

Settings
View

Edit
Utilities
Tapes
Disk/Y¥SAM
0AM
Templates
HFS

Exit

KO-~ oounmAaAWONONE O

Set processing options

View data

Edit data

Perform utility functions

Tape specific functions

Disk track and ¥SAM CI functions
Work with OAM objects

Template and copybook utilities
Access Hierarchical File System
Terminate File Manager

User ID

System ID :

Appl ID
Yersion
Terminal.
Screen.
Date.
Time.

'ON DEMAND BUSINESS

ALLANS2
STLABF2
ISR

8.1.0
3278A

1
2007/09/189
06:32
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Edit

Process Options Help

File Manager Edit Entry Panel
Command ===

Input Partitioned, Sequential or V¥SAM Data Set, or HFS file:

Data set/path name 'ALLANS2.FMDEMO.VSAM’ +

Member . . . . . . (Blank or pattern for member list)

Yolume serial . . (If not cataloged)

Start position . . +

Record limit . . . Record sampling

Inplace edit . . . _ (Prevent inserts and deletes)
Copybook or Template:

Data set name . . 'ALLANS2.FMDEMO.COPYBOOK'

Member . . . . . . DEMODATA (Blank or pattern for member list)

Processing Options:
Copybook/template Start position type Enter "/" to select option

1 1. Above 1. Key _ Edit template _ Type (1,2,5)
2. Previous 2. RBA _ Include only selected records
3. None 3. Record number _ Binary mode, reclen 80
4. Create dynamic _ Create audit trail

' DEMAND BUSINESS:




IBM Software Group

'ON DEMAND BUSINESS

Edit
Process Options Help
Edit ALLANSZ2.FMDEMO . VYSAM Top of 78
Command ===> Scroll PAGE
Type ESDS RBA Format TABL
REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
H2 H3 B4 H5 HE B
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27:.4 BI 31:4
<> {=-==#-=-=-=]-=-=--%----> {===+> ===#4> {-==4--> {-=--+----1>
xoaoxxxx xxxx  Top of data xxxx
000001 01 Graham Purdy 5512 24 68000 28
000002 01 Graham Purdy 5512 24 68000 28
000003 01 Al Tortorice 3101 39 53000 15
000004 01 Will Soper 4412 28 68000 5
000005 01 Tyrone Dalais 3312 21 65000 14
000006 02 Grant Sutherland 0309 2373 KOKKK KKK K 71124800
000007 02 Graham Purdy 0309 2373 KOKKK KKK K 71124800
000008 01 Silvano Prez 2161 55 69000 1
000009 01 Liz Rushton 3349 40 65000 14
000010 02 Silvano Prez 5193 8535 KKK K KKK X 41413184
000011 02 Don Pharoah 5193 8535 XXX KK KX 41413184
000012 01 John Nicholls 3349 40 69000 30
000013 01 Anna Waghorn 7812 33 65000 2
000014 01 Merrill Bani 7876 56 58000 18
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Edit
Process Options Help
Edit ALLANS2 . FMDEMO. VYSAM Top of 78
Command ===> X ALL Scroll PAGE
SHAD Type ESDS RBA Format TABL
REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
B2 B3 Ba #5 BB HY
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27:4 BI 31:4
<> {-==#---=]--=--%---=> {===#4> (===4> {-==#-=-> (--=+----1>
xoacxoxxx xxxx  Top of data xxxx
000001 01 Graham Purdy 5512 24 68000 28
000002 01 Graham Purdy 5512 24 68000 28
000003 01 Al Tortorice 3101 39 53000 15
000004 01 Will Soper 4412 28 68000 5
000005 01 Tyrone Dalais 3312 21 65000 14
000008 01 Silvano Prez 2161 55 69000 1
000009 01 Liz Rushton 3349 40 65000 14
000012 01 John Nicholls 3349 40 69000 30
000013 01 Anna Waghorn 7812 33 65000 2
000014 01 Merrill Bani 7876 56 58000 18
000037 01 Graham Purdy 5512 54 68000 28
000038 01 Al Tortorice 3101 39 65000 15
000039 01 Will Soper 4412 40 68000 5
000040 01 Tyrone Dalais 3312 21 66000 14
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Edit

Process Options Help

Edit ALLANS2.FMDEMO. VSAM Top of 78

Command ===> F 7812 H4 Scroll PAGE

Some shadows are off, so no records displayable
REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
H2 H3 H4 H5 HE HY
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27:4 BI 31:4
<> {===#====]-===%=-===> {===#4> (===4> {~==4=-=> {~-==4----1>

MK KKK MR Tnp of data xxxx
wkxkxx ¥xxkx End of data xxxx

'ON DEMAND BUSINESS
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Edit

Process Options Help

Edit ALLANS2.FMDEMO. VSAM Chars 7812 found

Command ===> F_40 (H2 #4 #5) ALL Scroll PAGE

SHAD Type ESDS RBA Format TABL
REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
H2 H3 H4 H5 H6 HY
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27:4 BI 31:4
<> {===#====]-===%=-===> {===+> ===#> {===4=-=> {-==4----1>

xxxxxx xxxx  Top of data xxxx

000013 01 Anna Waghorn 33 65000 2

wxkxxxx xxxx%x End of data =xxxx

'ON DEMAND BUSINESS
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g g g A

A EX WK KK

End of data

'ON DEMAND BUSINESS

Edit

Process Options Help

Edit ALLANS2.FMDEMO. VYSAM 3 string(s) found

Command ===> RESET Scroll PAGE

SHAD Type ESDS RBA Format TABL
REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
H2 H3 H4 H5 HG HY
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27:4 BI 31:4
<> {===#--==]-=-=--%----> {===+> (===#> {-==4--> {---+----1>

xoaoxxx xxxx  Top of data xxxx

000PE9 01 Liz Rushton 3349 40 65000 14

000012 01 John Nicholls 3349 40 69000 30

000013 01 Anna Waghorn 7812 33 65000 2

000039 01 Will Soper 4412 68000 5
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Tyrone Dalais
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Edit
Process Options Help
Edit ALLANSZ2.FMDEMO . VYSAM Top of 78
Command ===> SHAD SUP ON Scroll PAGE
SHAD Type ESDS RBA Format TABL
REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
H2 H3 B4 H5 HG HY
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27:.4 BI 31:4
<> {===#-===]-===%=-===> {===+> ===#> {===4=-=> {~-==4-=---1>
xoaxoxxx xxxx  Top of data xxxx
000001 01 Graham Purdy 5512 24 68000 28
000002 01 Graham Purdy 5512 24 68000 28
000003 01 Al Tortorice 3101 39 53000 15
000004 01 Will Soper 4412 28 68000 5
000005 01 Tyrone Dalais 3312 21 65000 14
000008 01 Silvano Prez 2161 55 69000 1
000008 01 Liz Rushton 3349 40 65000 14
000012 01 John Nicholls 3349 40 69000 30
000013 01 Anna Waghorn 7812 33 65000 2
000014 01 Merrill Bani 7876 56 58000 18
00037 01 Graham Purdy 5512 54 68000 28
000038 01 Al Tortorice 3101 39 65000 15
000039 01 Will Soper 4412 40 68000 5
000040 01 3312 21 66000 14
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Graham Purdy

'ON DEMAND BUSINESS

Edit
Process Options Help
Edit ALLANS2.FMDEMO. VYSAM Top of 78
Command ===> Scroll PAGE
SHAD Type ESDS RBA Format TABL
REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
H2 H3 H4 H5 HG HY
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27:4 BI 31:4
<> {===#--==]-=-=-=%=--=-=> {===#+> (===#) {-==4-=> {---+----1>
xoaokxkxx xxxx  Top of data xxxx
000001 01 Graham Purdy 5512 249 68000 28
000002 01 Graham Purdy 5512 249 68000 28
00003 01 Al Tortorice 3101 39 53000 15
000004 01 Will Soper 4412 28 68000 5
000005 01 Tyrone Dalais 3312 21 65000 14
¥V - - - - - - - - REC-TYPEB2 - - - - - - - - - - 2 Line(s) suppressed
00008 01 Silvano Prez 2161 55 69000 1
000009 01 Liz Rushton 3349 40 65000 14
R REC-TYPEB2 - - - - - - - - - - 2 Line(s) suppressed
000012 01 John Nicholls 3349 40 69000 30
000013 01 Anna Waghorn 7812 33 65000 2
000014 01 Merrill Bani 7876 56 58000 18
- == = = = - - - REC-TYPEB2 - - - - - = = - - - 20 Line(s) suppressed
000037 01 5512 54 68000 28
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Edit

Process Options Help

Edit ALLANS2.FMDEMO. VSAM Top of 78

Command ===> FS$S Scroll PAGE

SHAD Type ESDS RBA Format TABL
REC-TYPE NAME JOB-TITLE ADDR1 ADDR2
H2 H3 B4 H5 HE +
AN 1:2 AN 3:20 AN 23:14 AN 37:20 AN 57
<> {===#-===]l-==-4-===3 {---#-=-=1---> (-=-#---=-]l----4--=-=> {---%

xoaoxxxx xxxx  Top of data xxxx

R REC-TYPEBL - - - - - - - - - - 5 Line(s) suppressed

000006 02 Grant Sutherland Developer 22 Montrose S5t Thorn

000007 02 Graham Purdy Developer 256 Hay St Canni

R REC-TYPEBL - - - - - - - - - - 2 Line(s) suppressed

000010 02 Silvano Prez Programmer 48 Small Lane Mt P1

000011 02 Don Pharoah Programmer 661 Ayton Way Flore

- == = = = - - - REC-TYPEBL - - - - - = = - - - 3 Line(s) suppressed

000015 02 Grant Sutherland Developer 22 Montrose St Thorn

000016 02 Andrew Astle Developer 44 Eagle Rise River

000017 02 Graham Purdy Developer 256 Hay St Canni

000018 02 Bill Soper Developer 84 Murchison Rd Diane

000019 02 Tyrone Dalais Developer 92 Smith St Belmo

000020 02 Rod Turner Manager 184 Alexander Dve Swan

000021 02 Clive Nealon Manager 28 Bern Rd Middl
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Edit
Process Options Help
Edit ALLANS2.FMDEMO. VSAM Rec 6 of 78
Command ===> HEX ON Scroll PAGE
Type ESDS REA 400 Format SNGL
Top Line 1is 2 of 7
Current 01: REC-TYPED2 Length 80
Field Picture Typ Start Len Data
2 REC-TYPE XX AN 1 2 02
2 NAME ¥ (20) AN 3 20 Grant Sutherland
2 JOB-TITLE X (14) AN 23 14 Developer
2 ADDR1 ¥ (20) AN 37 20 22 Montrose St
2 ADDR2 X (20) AN 57 20 Thornlie
2 POSTCODE X (4) AN 77 4 6145
xxx End of record xxx

'ON DEMAND BUSINESS
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Edit
Process Options Help
Edit ALLANS2.FMDEMO. VSAM Rec 6 of 78
Command ===> FOR T Scroll PAGE
Type ESDS REA 400 Format SNGL
Top Line 1s 2 of 25
Current 01: REC-TYPEO2 Length 80
Field Picture Typ Start Len Data
2 REC-TYPE XX AN 1 2 02
FF
02
2 NAME ¥ (20) AN 3 20 Grant Sutherland
C989A4EAAB8998984444
79153024385931540000
2 JOB-TITLE X (14) AN 23 14 Developer
C8A89998944444
45553675900000
2 ADDR1 ¥ (20) AN 37 20 22 Montrose St
FF44D99R99A8B4EA44444
22004653962502300000

'ON DEMAND BUSINESS
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29351560795900000000

T K
= *

'ON DEMAND BUSINESS

Edit

Process Options Help

Edit ALLANS2.FMDEMO. VSAM Rec 6 of 78

Command ===> HEX OFF Scroll PAGE

Type ESDS REA 400 Format TABL

REC-TYPE NAME JOB-TITLE ADDR1 ADDR2
H2 H3 H4 H5 HE6 +
AN 1:2 AN 3:20 AN 23: 14 AN 37:20 AN 57
<> et N R LD SRl b e AR bl bl B bt D 2 Caluliah

000006 02 Grant Sutherland Developer 22 Montrose St Thorn
FF C989A4ERA88998984444 C8A89998944444 FF44D99RA9SA84EA44444 E8999
02 79153024385931540000 45553675900000 22004653962502300000 38695

000007 02 Graham Purdy Developer 256 Hay St Canni
FF C988894DA98A44444444 C8A89998944444 FFF4C8A4EA4444444444 (C8998
02 79181407494800000000 45553675900000 25608180230000000000 31559

R REC-TYPEBL - - - - - - - - - - 2 Line(s) suppressed

000010 02 Silvano Prez Programmer 48 Small Lane Mt P1
FF E89A8994D98A44444444 D9989899894444 FF44E98994D898444444 DA4D9
02 79679144590000 48002413303155000000 43073
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ECEIrI‘tocess Options Help
Edit ALLANS2.FMDEMO. VSAM Rec 6 of 78
Command ===> Scroll PAGE
Type ESDS RBA 400 Format TABL
REC-TYPE NAME JOB-TITLE ADDR1 ADDR2
H2 H3 H4 H5 HE6 +
AN 1:2 AN 3:20 AN 23: 14 AN 37:20 AN 57
<> {-==+--=-=-1l----4----2> {---4--=--1---> {---4----]----4----> ---+
000006 02 Grant Sutherland Developer 22 Montrose St Thorn
000007 02 Graham Purdy Developer 256 Hay St Canni
¥ - - - === - - REC-TYPEBL - - - - = = = = - - 2 Line(s) suppressed
000010 02 Silvano Prez Programmer 48 Small Lane Mt P1
000011 02 Don Pharoah Programmer 661 Ayton Way Flore
e REC-TYPEBL - - - - = = = = - - 3 Line(s) suppressed
000015 02 Grant Sutherland Developer 22 Montrose St Thorn
000016 02 Andrew Astle Developer 44 Eagle Rise River
000017 02 Graham Purdy Developer 256 Hay St Canni
000018 02 Bill Soper Developer 84 Murchison Rd Diane
000019 02 Tyrone Dalais Developer 92 Smith St Belmo
000020 02 Rod Turner Manager 184 Alexander Dve Swan
000021 02 Clive Nealon Manager 28 Bern Rd Middl
000022 02 Jim Alexander Manager 123 Wellington St Gilfo
000023 02 Silvano Prez Programmer 48 Small Lane Mt P1
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Edit
Process Options Help
Edit ALLANS2 . FMDEMO. VSAM Rec 7 of 78
Command ===> C ALL 65000 60000 H6 Scroll PAGE
Type ESDS REA 480 Format TABL
REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
H2 B3 ) 5 HO H7
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27:.4 BI 31:4
<2 {---+----1----+----> {---+> ---1> {-——+--2 {-—--+----1>
- - - === - - - REC-TYPEB2 - - - - - = = = - - 2 Line(s) suppressed
000008 01 Silvano Prez 2161 55 69000 1
000009 01 Liz Rushton 3349 40 65000 14
- - = === - - - REC-TYPEB2 - - - = = = = = = - 2 Line(s) suppressed
000012 01 John Nicholls 3349 40 69000 30
000013 01 Anna Waghorn 7812 33 65000 2
000014 01 Merrill Bani 7876 56 58000 18
e REC-TYPEB2 - - - - - - - - - - 20 Line (s) suppressed
I R R I I R 2 Line(s) not selected
000037 01 Graham Purdy 5512 54 68000 28
000038 01 Al Tortorice 3101 39 65000 15
000039 01 Will Soper 4412 40 68000 5
000040 01 Tyrone Dalais 3312 21 66000 14
S R T R R R T IR I I 2 Line(s) not selected

- - - - - - - - REC-TYPEG2 - - - - - - - - - - 2 Line(s) suppressed
s EMAND BUSINESS
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REC-TYPED2

20 Line(s) suppressed
2 Line(s) not selected

'ON DEMAND BUSINESS

Edit

Process Options Help

Edit ALLANS2.FMDEMO. VSAM 4 string(s) changed

Command ===> Scroll PAGE

Type ESDS RBA Format TABL

REC-TYPE NAME EMPLOYEE-NO AGE SALARY MONTH (1)
H2 H3 H4 H5 HG B
AN 1:2 AN 3:20 BI 23:2 BI 25:2 PD 27.4 BI 31:4
<> {===#--==]-=-=-=%=--=-=> {===#+> ===#)> {-==4-=> {---4+----1>

xaoxxxx xxxx  Top of data xxxx

000001 01 Graham Purdy 5512 24 68000 28

000002 01 Graham Purdy 5512 24 68000 28

00003 01 Al Tortorice 3101 39 53000 15

000004 01 Will Soper 4412 28 68000 5

000005 01 Tyrone Dalais 3312 21 60000 14

R REC-TYPEB2 - - - - - - - - - - 2 Line(s) suppressed

00008 01 Silvano Prez 2161 55 69000 1

000009 01 Liz Rushton 3349 40 60000 14

R REC-TYPEB2 - - - - - - - - - - 2 Line(s) suppressed

000012 01 John Nicholls 3349 40 69000 30

000013 01 Anna Waghorn 7812 33 60000 2

000014 01 Merrill Bani 7876 56 58000 18
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Utilities

= Copy data
» Select records/fields using Boolean expressions
» “Map” fields from an input file to an output file
» Reformat and generate data while copying
» Field values can be “scrambled” to protect sensitive data
» Copy data into XML format

= Global Find/Change

» Search for/change data across members in a PDS(E)
» Perform a new search based on the results of a previous search

= Compare
» Compare records/fields between files
» Use field level mapping for comparison criteria
» Special options for load module comparisons

MAND BUSINESS
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Utilities

Process

Options Help

File Manager

Command ===>» 3

-1 AaAONDPEFE O

Settings
View

Edit
Utilities
Tapes
Disk/VSAM
OAM
Templates
HFS

Exit

Primary Option Menu

Set processing options

View data

Edit data

Perform utility functions

Tape specific functions

Disk track and V¥SAM CI functions
Work with OAM objects

Template and copybook utilities
Access Hierarchical File System
Terminate File Manager

User ID

System ID :

Appl ID
Version
Terminal.
Screen.
Date.
Time.

'ON DEMAND BUSINESS

ALLANS2
STLABF2
ISR

8.1.0
3278A

1
2007/09/18
07: 44
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Utilities — Compare Data

Process Options Help

File Manager Utility Functions
Command ===> 11

0 DBCS Set DBCS data format for print
1 Create Create data

2 Print Print data

3 Copy Copy data

4 Dslist Catalog services

5 VTOC Work with VTOC

6 Find/Change Search for and change data

7 AFP Browse AFP data

8 Storage Browse user storage

9 Printdsn Browse File Manager print data set
10 Loadlib Load module utility functions
11 Compare Compare data

12 Audit trail Print audit trail report

13 Copybook View and Print

'ON DEMAND BUSINESS




| IBM Software Group
Utilities — Compare Data

Process Options Help

File Manager Compare Utility : 0l1d Data Set
Command ===
More:
"01d” Partitioned, Sequential or VSAM Data Set, or HFS file:
Data set/path name . . 'ALLANS2.FMDEMO.VSAM'
Member . . . . . . . . (Blank or pattern for member list)
Yolume serial . . . . . (If not cataloged)
Start key . . . . . . . key or slot
Skip count . . . . . . DO number of records to be skipped
Compare count . . . . . ALL humber of records to be compared
"01d"” Copybook or Template:
Data set name . . . . . 'ALLANS2.FMDEMO.TEMPLATE'
Member . . . . . . . . DEMODATA (Blank or pattern for member list)
Processing Options:
Copybook/template usage Enter "/" to select option
1 1. Above _ Edit template _ Type (1,2,5)
2. Previous _ Advanced member selection
3. None _ Skip member name list
4. Create dynamic _ Batch execution

Binary mode, reclen

DEMAND BUSINESS
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Utilities — Compare Data

Process Options Help

File Manager Compare Utility : New Data Set
Command ===

"New"” Partitioned, Sequential or VSAM Data Set, or HFS file:

Data set/path name . . “ALLANS2.FMDEMO.COMPNEW'

Member . . . . . . . . (Blank or pattern for member list)
Yolume serial . . . . . (If not cataloged)

Start key key or slot

Skip count . . . . . . nhumber of records to be skipped
Compare count . . . . . number of records to be compared

"New" Copybook or Template:

Data set name . . . . . _ALLANS2.FMDEMO.TEMPLATE’
Member . . . . . . . . COMPNEW (Blank or pattern for member 1list)
Processing Options:
Copybook/template usage Enter "/" to select option
1 1. Above _ Edit template _ Type (1,2,5)
2. Previous _ Binary mode, reclen
3. None

4. Create dynamic

'ON DEMAND BUSINESS
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Utilities — Compare Data

Process Options Help

File Manager
Command ===

Compare Utility

Options

Compare Options:
Compare type synchronization
2 1. Record 1l 1. One-to-one
2. Formatted 2. Read-ahead
3. Keyed

Processing Options:
Enter "/" to select option
_ Edit template mapping
/  Clear print data set
Create result data sets

ISPF Packing

1l 1. Unpack if packed
2. None
3. Skip

More:

Listing type Long Report

2 1. Summary Enter "/" to exclude
2. Delta _ Inserted
3. Matching Deleted
4. Long _ Changed
5. None Matched

Listing Options:
Enter "/" to select option
/ HWide listing
_ Show hex chars
/ Highlight changes
Show field attributes
Show changed fields only
Always show SELECTed fields

Number of differences to report ALL

|DEMAND BUSINESS'
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Utilities — Compare Data - Output

Process Options Help

Print Brouse ALLANS2.FMN.LIST Rec 18 of 122
Command === Scroll CS5R
Record 18 Col 2 Format CHAR

---+----1----4----2----4----3----4----4----+----Bb----4----f----+----F----+----8
x x x Formatted comparison with one-to-one synchronization

* New data set: ALLANS2.FMDEMO.COMPNEW

X using template ALLANS2.FMDEMO.TEMPLATE (COMPNEW)

x 01d data set: ALLANS2.FMDEMO.VYSAM

X using template ALLANS2.FMDEMO.TEMPLATE (DEMODATA)

New data set fields: REC-TYPE NAME EMPLOYEE-NO AGE SALAR
ID NREC-# OREC-# <O {-==#--=--1----+--=--3 {-==+> (---%> {---+--
C 000005 01 Tyrone Dalais 3312 21 6500
Old data set fields: REC-TYPE NAME EMPLOYEE-NO AGE SALAR
ID NREC-# OREC-# <O {===#====]=-==-=4=-===> {===#> (===4> (---4--
0 000005 01 Tyrone Dalais 3312 21 |||T???
C 000009 01 Liz Rushton 3349 40 6500
0 000009 01 Liz Rushton 3349 40 |||T???
C 000013 01 Anna Waghorn 7812 33 6500
0 000013 01 Anna Waghorn 7812 33 6000

MAND BUSINESS
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Utilities — Compare Data - Output

Process Options Help

Print Brouse ALLANS2.FMN.LIST
Command ===

Rec

Record 37

37 of 122
Scroll CSR
Format CHAR

R e R B Ry CEEEEEEEEY:

IBM File Manager for z/0S
Comparison summary:

Old data set records processed:
New data set records processed:
Matching records found:

Changed records:

Old records not selected:

New records not selected:

Old records not compared:

New records not compared:

Old data set records deleted:
New data set records inserted:
Synchronization:

Comparison type:

Listing type:

Listing options:

One-to-one
Formatted

Delta

Wide listing
Highlight changes

|DEMAND BUSINESS'
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File Manager CICS Features

= |ISPF-like panels = Support for extended
= Full function edit and view addressability ESDSs
» Table = Interface to File Manager z/OS
» Single = Interface to File Manager IMS
= Flexible selection criteria = Modes Of Operation
» Work with copybooks or templates » Interactive
= CICS Resource = Interfaces
» File » CICS
» Temporary Storage = Support for IBM Software
» Transient Data » CICS TS V3.2
= Print data

List Resources

'ON DEMAND BUSINESS
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Starting File Manager for CICS

ERZ -~ % [N on DEVAND BUSINESS
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FM / CICS Primary Option Menu

Process Options Help

FM/CICS Primary Option Menu

0 Settings Set processing options User ID . : ALLANSC

1 View View data CICS User : ALLANSC

2 Edit Edit data CICS Appl : CICSC31F

3 Utilities Perform utility functions Date. . . : 2007/09/27
4 Templates Template and copybook utilities Time. . . : 06:26

FM FM File Manager z/0S

FI FM/IMS File Manager for IMS z/0S

X Exit Terminate FM/CICS

Processing Options:

CICS Resource

1 1. File
2. Temporary Storage
3. Transient Data

Command ===> _2
Fl=Help F3=Exit F4=CRetriev F7=Backward F8=Forward F1l0=Actions
F12=Cancel

'ON DEMAND BUSINESS
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Edit - CICS File

Process Options Help

FM/CICS Edit CICS File Entry Panel
Input CICS VSAM File:
File name . . . . FMCUST
Sysid . . . . .
Start position . . +
Record l1imit . . . Record sampling
Inplace edit . . . _ Prevent inserts and deletes
Lock resource . . _ Name
Copybook or Template:
Data set name . . 'ALLANSC.ADDEMO.FMCICS.COPYBOOK'
Member . . . . . . CUSTFILE (Blank or pattern for member list)

Processing Options:
Copybook/template Start position type Enter "/" to select option

1 1. Above 1. Key _ Edit template _ Type (1,2,5)
2. Previous 2. RBA _ Include only selected records
3. None 3. Record number _ Create audit trail

4. Create dynamic

Command ===>

Fl=Help F3=Exit Fd4=Expand F7=Backward F8=Forward F10=Left
F11=Right F12=Cancel

'ON DEMAND BUSINESS
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Edit - CICS File

Process Options

ADDEMO. CU
+ Type KSDS

Edit FI:FMCUST DS:ALLANSC.
Key
Customer Name
B2
AN 1:81
{---+----1----+---->

xakxkk xxxx  Top of data

000001 helena smith

NO-SHARES

2D 82:4 AN 94: 4

000002 helena smith

000002 helena smith

000004 justine grose

000005 justine grose

000006 justine grose

000007 justine grose

000009 Keiron casey

000010 peter niblett

000011 peter niblett

Command ===> X ALL

At top
Format TABL

BUY-FROM-NO BUY-TO

00080.00

00215.00
00026.00

00200.00
1 Line(s) not selected

00012.00
00120.00

5 Line(s) not selected
Scroll PAGE

Fl=Help F2=Z2oom
F8=Doun F10=Left

F3=Exit
F11=Right

F4=Expand
Fl12=Cancel

F5=RFind  F7=Up

MAND BUSINESS
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Application Performance Analyzer Features

| IBM Software Group

Application Performance Analyzer for z/OS collects samples from a
monitored address space and analyzes the system or resource application
in the following categories:

Total address space utilization of all modules in the address space

CSECT utilization within each load module

Instruction or statement utilization within each CSECT

Assembler, COBOL and PL/I statements utilization within each module

MQSeries® queue information

DASD statistics, including VSAM information

CPU usage

DEMAND BUSINESS
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Application Performance Analyzer for z/OS (APA)

=Key features New in APA V8.1

» Measure and report resource use in virtually any . Java Enhancements
IBM z/OS® address space

» Isolate application performance problems - Unix System Services support

» Pinpoint performance bottlenecks « Report Enhancements
» Identify constraints

» Non-intrusive

» Helps with design, development and maintenance

» Shares side files with Fault Analyzer and Debug
Tool

=IBM Product Support

» Supports C/C++, Assembler, COBOL, PL/I, Java
and CICS, DB2, IMS, WebSphere MQ and
WebSphere Application Server

» CICS TS V1 to V3, IMS V7 to V10, DB2 V7 to V9

« Usability Enhancements

MAND BUSINESS




Application Performance Analyzer Features

| IBM Software Group

Summary/Profile reports with drill down into detailed levels via an ISPF
interface or PDF hardcopy

CPU, Load Module, and CSECT analysis of all modules in the address
space

Source statement (COBOL or PL1) or instruction utilization in each CSECT
Supports Fault Analyzer / Debug Tool Sidefiles
Wait time analysis by category, task/module, or attribution

DASD I/O analysis by device, DDNAME, dataset and dataset attributes,
EXCP’s, VSAM with buffer pool, 1/0O wait, over time

SYSPLEX coupling facility reports

CICS session statistics, transaction analysis by CPU usage, mean and total
service time, and waits by transaction

MAND BUSINESS
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Application Performance Analyzer Features

= Types of Observation Sessions
» Real-Time
» Scheduled
» Via batch submission
= Non-intrusive performance analyzer for applications and systems
programmerss to
» Improve response time in online applications
» Improve batch turn around time
» Identify excessive I/O activity
» Identify excessive CPU usage
» Test the effects of increasing workload
» Isolate performance problems in new and existing applications

= Support for IBM Software
» CICS TS V3.2
» DB2 V9
» IMS V10

'ON DEMAND BUSINESS
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Application Performance Analyzer - Provides rapid pinpointing of
enterprise application bottlenecks

@ Series

IS0 User: JAVA

Observation session

REN\Za

Print reports from z/0S | _ Application
) Performance
Analyzer
| bottlenecks

in

application
code

View reports
View reports in PDF format on PC
online with IS




| IBM Software Group

Application Performance Analyzer Report Summary

CPU

Usage by Category
Usage by Procedure
Usage by Module
Referred Attribution
Usage by Code Slice
Usage Timeline
Usage Task/Category
Usage Task/Module

MQSeries

Activity Summary

Serv Time by Txn

CPU Usage by Queue
Wait Time by Queue
CPU Usage by Request
Wait Time by Reque
CPU Usage by Txn
Wait Time by Txn

Serv Time by Queue
Serv Time by Request

|UN DEMAND BUSINESS
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Schedule Options

File Miew MNavigate Help

Row ooool of 00005

RO3: Schedule New Measurement
Command === Sengll===F L5H
# 1. Job Information d. Multi Steps 5. CICS Txns @ 7. Schedule

i Chntiiess 4. Actiwve Jobs b. Sysplex G- ched Options

Schedule Options

Specify if the job is actiwve and is to be measured immediately (%) or if
AF-Analyzer is to wait for the job to be submitted (N):

Measure active job [¥/N) . . . . [@

Repeat the measurement if the johb
runs more than once within the
specified interwval.

Times to repeat measurement . __
Within interwval [(minutes)

|DEMAND BUSINESS'

14036



| IBM Software Group

S01: Measurement Profile - Suggested Start for Navigation

File

Miew Mawigate Help

RE1:

IBM AFA for z/05 Performance Reports [0018)

Cammand ===3

select a category from
the list to the right

to wiew the awailable
reports in the selection
list below.

AdminsMiscel laneous

CFU Usage Analysis
DASD I/0 Analysis
CFU WAIT Analysis

EoOaon I
e mmH

Fow 00001 of 00007
Scroll ===» CS5R

IMS Measurement
CICS Measurement
DBEZ Measurement
MO Measurement
Coupling Facility

Enter 5 to make a selection or enter the report code

| JIey

=1
10
{036
=g
=5
{0

Measurement Frofile

Load Module Attributes
Load Module Summary

TCE Summary

Memory Usage Timeline
Data space Usage Timeline

on the command line

_ 07 TCE Execution Summary
_ o8 Frocessor Utilization Summary

'ON DEMAND BUSINESS
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S01: Measurement Profile - Summary

File Wiew HMNawigate Help

501: Measurement Profile (0015) Row 00001 of Q2075
Command === Scroll === [C5R
r0werall CPFU Actiwity R e t=:
Samples 2,889 1oo,o0% 1) Coz LCO3 Cob
CPU Actiwe £, 065 g, 1y  — Wil Wag
WAIT 1 o, 0y |
Queued £3 0, Ty M
FCPU Uzage Distribution rReports:
CPU Actiwe 2,865 1oo.ox 000 Col Cobs ol
Application 256 §.9y =
Syu=tem £, B9 91 . 0%
DEz2 S0OL 2 0,0
Data Magmt 2 o, o
Unre=solwed i (OO )
FCPU Modes rReports:
Actiwe CPU 2,865 100,0% ' 508
Supw Mode =
MAJR a
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CO01: CPU Usage by Category

File Wiew HMNawigate Help

Col: CPU Usage by Category [(O0185) Row Q0001 of Q2002

Command === Scroll === [C5H

MHame Dezcription Fercent of CPU Time * 10.00% +1.,8%
#,...1....2....3....4....58....6....7....8

SYSTEM 5I=.|S'tE‘-'IT|x"'|:|5 Cervices 91 .06 |

APFLCH Application Code §.93 -

MAJR a A R Fgnlohe

I_UN DEMAND BUSINESS
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- Expand 3 levels

File Wiew HMNawigate Help

Col: CPU Usage by Category [(O0185)

Command ===

MHame

Fow Q0001 of Qo022
Scroll === [C5H

Description

STYSTEM

+ZELCH

Sysztem-05 Serwvices
Application Code

Fercent of CPU Time * 10, 00% 1. 8%
#,...1....2....3....4....58....6....7....8
91 .06 |

g.93 |
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CO01: CPU Usage by Category - Expanded

File Wiew HMNawigate Help

Col: CPU Usage by Category [(O0185) Row 00001 of Q0005
Command === Scroll === [C5R
Mame Description Fercent of CPU Time *® 10,00% +1., 8%
#.,.,..1....2....3....4....5....6....7....8

SYSTEM System~05 Services 1, (2 |
BFFLCH Application Code §.93 -
+ VWSAMWEBETE Application Program §. 93 -

+ WSAMWRBTE CSECT in WSAMWRTE §. 75

+ CEELOCT LE Runtime Module 0,17
MAJR a A L9002

I_UN DEMAND BUSINESS
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Enter P to view program source

File Wiew HMNawigate Help

Col: CPU Usage by Category [(O0185) Row 00001 of Q0005
Command === Scroll === [C5R
Mame Description Fercent of CPU Time *® 10,00% +1., 8%
#.,.,..1....2....3....4....5....6....7....8

SYSTEM System~05 Services 1, (2 |
APFLCH Application Code §.93 -
+ VWSAMWEBETE Application Program §. 93 -

+(FPERAMWBTE CSECT in WSAMWRTE §. 75

-+ ELOCT LE Runtime Module 0,17




File
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P01 Source Program Attribution

Wiew

Mawigate Help

PO1:

Command ===

Source Program Attribution [(20185)

Fow Q0001 of Qo047
Scroll === [C5H

LineMo Off=et Count Source Statement

ojelojelcic]
ojeloleler
ojelojalc)s
ojelojahey=
DEEE ST
ojelojajeys)
ojelojolcls]
QOO0 40
ojolofo N
pooog2
CIEEE 43
Dooo 44
DEEE 45
Dooo4E
DEEE ST
Dooo 45
CEEE 49

0 |

3

Doo536E
DECSg4
DoossC
ojoloag 1=
DODERE
PEoaco
Doasbo
ojolo)oy =
DOOEZ4
DEE30
DOoE90
DEOERZ
DODBEEBA
orololSy =

17

20

17

FROCEDURE DIYISION.

MAIM-PARA.
DISPLAY *START PARA’.
FERFORM START-FARA.

BEEEEEE ChL-FARA UNTIL TIME-IMTERVAL > TIME-DURA

FERFORM OPEMN-PARA.
INITIALIZE TIME-START , TIME-STOP , TIME-INTERVA
FERFORM START-FARA.
EEEEEAL - FARA UNTIL TIME-INTERVAL » TIME-DURA
DISPLAY 'WRITE FPARA’.
FERFORM IMITIALIZE-PARA.
FERFORM WRITE-FPARA VARYING I FROM 1 BY 1 UMTIL I
INITIALIZE TIME-START , TIME-STOF , TIME-INTERVA
FERFORM CLOSE-FARA.
FERFORM START-FARA.

st CAL-PARA UMTIL TIME-IMTERYAL > TIME-DURA

ﬁ ‘Eii:

'ON DEMAND BUSINESS
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PO1: Source Program Attribution

File Wiew

Hawigate Help

Pol: Source Program Fttribution [(O013) Row Q0015 of QC047
Command === Scroll === LC5H
LineMo Off=set Count Source Statement
QoO0049 oooEDE 17 =l CAL-FARA UMTIL TIME-IMTERWYAL > TIME-DURA
jlojolo={ouaialoiNo! STOFP RUM.
Q0051
[olojo]oR P CAL-FPARA.
QEOOO53 00T 30 21 s N F - FARA.
CICEE 54
Q0055 START-PRRA.
QOOORE QDO T4E ACCEPT TIME-START FROM TIME.
QOO057T
QOG5S STOFP-FARA.
QOO059 QOOTEE 47 ACCERPT TIME-STOP FROM TIME.
ELSEI-EN - CF time attributed to akbi statement
QOOORD CDOTCE 129 COMPUTE TIME-IMTERY = TIME-STRRET - TIME-STOP.
jlojojo) Nk
Q006 S IMITIALIZE-FARA.

ojolojo] 3
ojole]

TO TABLE-WALUES(1).
TO TAEBLE-YALUES(Z].

'ON DEMAND BUSINESS
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CO05: CPU Usage by Task/Category - Expanded

File Wiew HMNawigate Help

Co5: CPU Usage by Task-Category [(Q015) Fow Q@001 of Q0015
Command === Scroll === [C5R
Mame Dezcription Fercent of CPU Time *® 10,00% +1, 3%
®, ... 1.2, ...3....4....85....6....T....10.
VSAMWRTE-001 TLCE=GOOSCADgG LRG0, Ao |
+ SYSTEM Sgﬂtemf’l:lﬁ g1 . QR |
Serwvices
+ BFPLCH Application Code §.937 N
+ VSAMWETE Applicatiaon §. 93 -
Frogram
+ YWSAMWRETE CS5SECT in §. 75 T
YWSAMWRTE
+ CEELOCT LE FRuntime 0.17
Module
+ DATAMG Data Mamt QL e
Froces=sing
+ DBEZSQL SL Processing o, e
IEAYARDD -2 TCE=Q0OGFECASG QL e
IEAYTSDT -3 TCE=Q0OGFFEGS oL a0
IEESBERE-@2d4 TCE=OOSGFFEFG QL e

MAJR a

I_UN DEMAND BUSINESS
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CO07 CPU Usage by Procedure

File Wiew HMNawigate Help

CoT: CPU Usage by Procedure [Q3215) Fow Q0001 of Q0006

Command ===> [ Scroll === [C5H

Program Procedure MName Fercent of CPU Time * 10.00% +1.,8%
#,...1....2....3....4....58....6....7....8

YSAMWETE STOFP-FARA £.1< S

VYSAMWETE MAIM-FARA 1.0 =

YSAMWETE CARAL-FARA G, 73

SYSTEM 5I=.|S'tE‘-'IT|x"'|:|5 Cervices 91 .06 |

APFLCH Mo Procedure Mapped 2,17

04,015

I_UN DEMAND BUSINESS
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Enter P to View the Source Listing

File W¥iew Hawigate Help

Co7: CPU Usage by Procedure [Q00183)

Row 0QOO001 of QOOOB

Command === Scroll === [CS5H

Frogram Frocedure Mame Fercent of CPU Time ® 10.00% *1,85%
®,...1....2....23....4....5....6....F....18

FEHMLLIHTE STOF-FPARA E.1

YSAMWBTE MAIM-FPARA 1.5 =

YSAMWRBRTE CAL-FARRA D, T3

SY STEM 5I=.|S'tE.'I'|'|f"|:|5 CServices 91 .06 |

AFFLCH Mo Procedure Mapped .17
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PO1: Source Program Attribution

File W¥iew Hawigate Help

Pol: Source Program Fttribution [(O013)

Command ===

Fow G002l of 00047
Scroll === [CS5H

LineMo Off=et Count Source Statement

FROM TIME.
FROM TIME.
statement

RvAL = TIME-STRRT - TIME-5TOP.

TO TAEBLE-YALUES(1].
TO TABLE-WALUES(Z).
TO TAEBLE-YALUES(19].
TO TABLE-VALUES(ZO]).

QOO052 CAL-FPARA.

QOEOE05S D00 T30 21 TI:IF'—F'F|F:|"—'|

QG054

[olojojo}=gs START-PARA.

QOOO5E QDO T4E ACCEPT TIME-START

[olojolo}=1r

COO05E STOP-FARA

QOO05Y Q0O T7TEE 47 CEET TIME-STOPR
PSRN - CFll time attributed to ab

QOOORD Qoo 7CE 129 COMPUTE TIME-IMTE

QOO0 EL

QOG0 E S IMITIALIZE-FARA.

QGO0 ES

QOOORdG Qoo 7FZ MOVE 'SIRISHA'

QOOOES QOO TFS MOVE ' SUSARLAY

QOOOGS Qo055 E MOVE 'WEEMA'

QOOO53 000564 MOVE ' SOMALT!

CICEE 5 4

MAJR a A

D8 041

'ON DEMAND BUSINESS
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WO01: WAIT Time by Task/Category - Expanded

File W¥iew Hawigate Help
Wal: WAIT Time by Task<Category [(OO15) Fow ool of o013
Command === Scroll === [CS5H
Hame Dezcription Fercent of Time in WAIT *® 10,00% +1.38%

YSAMWRTE-QO]1 TCB=oogCAD9D

+ SYSTEM System-05
Services
+ 5[ SWC Routines
+ BvCols ELOL-FIMD
+ APPLCH Application Code
+ DATAMG Data Mgmt

Froces=sing

[EAVARDO-00Z TCB=O0OSGFEDASD
[EAVTSDT-003 TOB=0OSFFEGS
[EESBEOS-004 TCB=0OSFFBFG
[EFIIC-005 TCE=ROGE9GEBL

MAJR a

o R o R e i

o R o R e

L3
L3

L3
L3
ol
ol

ol
ol
ol
ol

T = T T (I =

12,008

I_UN DEMAND BUSINESS
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W02: WAIT Time by Task/Module - Expanded

File View

Mawigate Help

Woz: WAIT Time by Task-Module [(Q218)

Command ===5

Row QOoOl of QOOO9

Mame Description

BSAMWRTE-G001 TCE=008CADI0

+ JECE1E Superwisor
Control
+ SVYLOR13 ELOL-FIMD

[EAVAROO -0 TLE=QLSFECAG
IEAVTSOT-003 TCE=0OSFFESS

IEESBEOS-004 TLE=QLSGFFEFG
TCE=00SE9EEBD

IEFIIC-005

Scroll === [CS5R
Fercent of Time in WAIT *® 1@, Q0% 1. 8%
e T T e

DD DD D DD

L3
L3

L3

oo
o
oo
o

o= pgalop

I_UN DEMAND BUSINESS
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DASD I/O Analysis “D” Reports

File View Navigate Help
IBM APA for z/0S Performance Reports (0089) Row 00001 of OOOOY

Command ===> |} Scroll ===> CSR

Select a category from _ A Admin/Miscellaneous I IMS Measurement

the 1ist to the right _ S Statistics/Storage E CICS Measurement

to view the available _ C CPU Usage Analysis _ F DB2 Measurement

reports in the selection I RDASD I/0 Analysis _ Q MQ Measurement

list below. _ W CPU WAIT Analysis G Coupling Facility

Do1
Do2
DO3
Do4
DO5
D06

Enter S to make a selection or enter the report code on the command line

DASD Usage by Device _ Do7 DASD Activity Timeline
DASD Usage by DDNAME _ Dbo8 DASD I/0 Wait Time
DASD Usage by Dataset _ D09 VvSAM Buffgr Pool Usage

Dataset Attributes
DASD EXCP Summary
DASD VSAM Statistics

04/015

'ON DEMAND BUSINESS
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D03: DASD Usage Time By Dataset - Expanded

DO3: DASD Usage Time by Dataset (0145)

Command ===>

Row 00001 of 00005
Sroll ===> CSR

Dataset Name>DDName

MACHIND.TEST.ESDS10M. JANOS
MACHIND.FMNeses$ . TEMPesel
BACHIND.TEST.ESDS10M.MSTAPRO3

ISP.SISPLOAD
+ STEPLIB IPL14D

Percent of Time x 10.00% +1,0%
5....

x,,..1....2....3....4.... 6....7.

.05 H
.91
.56
.01
.01

s I s Y s I e Y

10/002

I_UN DEMAND BUSINESS



2{ Session C - [24 x 80] =JO/ed

File Edit View Communication Actions Window Help

B B o B ] % & @ @@

File V¥iew Navigate Help

D04: Dataset Attributes (7773) Row 00001 of 00105
Command ===> ! Scroll ===> PAGE

SORT by: DDName enter SF, by Dataset Name enter SD.
Dataset information reported for 4 files.

¥YSAM file FILE1l OPENed at 16:41:36.67 Tuesday Oct 23 2007

DDNAME FILE1
Open Intent KEY, SEQ, IN
Dataset Name ADTOOLS.APA. VSAM. DAT
Storage Class MEDIUM
Device Type 3390
% Free Bytes in CI 10% Initial Last
Volume Serial SMS004 CI Splits 1 1
CI Size 8,192 CA Splits 0 0
Record Size (LRECL) 14 Logical Records 2,102 2,102
Number of Extents 1 Deleted Records 182 182
SHAREOPTIONS (1 3) Insrted Records 2 2
Organization KSDS Retrved Records 12,009, 149 12,009,271
Fl=Help F2=5plit F3=End Fd=Jump F5=Rfind F7=Up F8=Down
F9=Swap FlO0=Left F11=Right F12=Cancel
MAll ¢ 04/015

@ |Cunnected to remote serverfhost 9,30, 128, 24 using lufpool TCPO0D21 and port 23 |ussu||ﬁ—F426—04—F—5ili::on Vall on MedD: -
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D05: EXCP Summary — Expanded Detall

File WView Nawvigate Help

m More: +
The following report line was selected
SYS00038-1 VSAM-DATA 11 220 209

VSAM file SYSOO038(1) OPENed at 6:49:55.48 Tuesday May 10 2005

DDNAME SYS00038
Open Intent KEY,DIR, SEQ, OUT
Dataset Name MACHIND.FMNe$es$ . TEMPesel . DATA
Storage Class MEDIUM
Device Type 3390
% Free Bytes in CI 0% Initial Last
VYolume Serial STFG630 CI Splits 0 0
CI Size 18,432 CA Splits 0 0
Record Size (LRECL) 84 Logical Records 55,080 1,084, 655
Number of Extents 1 Deleted Records 0O 0
SHAREOPTIONS (2 3) Insrted Records O 0
STEPLIB Non-VSAM +3 28 250 222
STEPLIB Non-VSAM +4 28 250 222
SYS00038-3 VSAM-DATA 2777 2888 111
1Al a 03/004

'ON DEMAND BUSINESS
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DO7: DASD Activity Timeline

& File View Navigate Help

DO7: DASD Activity Timeline (0145) Row 00001 of 0O034C
Command ===> [ Scroll ===> L3R
File Information —— 100,000 Samples: Duration 14399.8 Seconds —

I
DDN: STEPLIB >80%
Type: HNon-VSAM >60%
Vol: IPL14D >40%
Unit: 3390 >20%

>ox | |1 | 111 mnm 1
| ..... 1....2....8....4....5....6....7....8....9.....

|
DDN: SYSO0037-4 >80%

Type: VSAM >60%
Vol: STF634 >40%
Unit: 3390 >20%

> 0%
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Viewing the PDF Report

T Hie Edt View Uocument lools Window Help Cmox
CRE N[O @ W L e e B e m

SR | 0at=:  Woinesdey ey 11 2006 91135 IBMAPA.  Performance Aﬂ:ﬁf Page 1
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Advantages

= 2/OS Problem Determination and Deployment Tools that:
» Exploits IBM'’s latest software and processor technology
» Offer wide array of key features and functions
» Can enhance the Application Development Lifecycle
» Provide opportunity for increased user productivity
» Are affordably priced
» Have flexible terms and conditions
» Have no license keys

'ON DEMAND BUSINESS
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For More Information

= z/0OS Problem Determination and Deployment Tools
» www.ibm.com/software/awdtools/deployment
» www.ibm.com/software/awdtools/faultanalyzer
» www.ibm.com/software/awdtools/filemanager
» www.ibm.com/software/awdtools/debugtool
» www.ibm.com/software/awdtools/apa
» www.ibm.com/software/awdtools/apaaa
» www.ibm.com/software/awdtools/workloadsimulator
» www.ibm.com/software/awdtools/tester/functional
» www.ibm.com/software/awdtools/tester/performance/zos
» www.ibm.com/software/awdtools/migration
» www.ibm.com/software/awdtools/tictoc/
» www.ibm.com/software/awdtools/ispfproductivitytool
» www.ibm.com/software/awdtools/fileexport

ON DEMAND BUSINESS
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For more information

= Help Center
= http://publib.boulder.ibm.com/infocenter/pdthelp/viri/index.isp

= Redbooks
= www.redbooks.ibm.com/abstracts/sq247372.html

'ON 'DEMAND BUSINESS
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For More Information

= Training
» Services
= Mentor Workshops

» Free Web-based
= Application Performance Analyzer

= Debug Tools Utilities and Advanced Functions

= Fault Analyzer

= File Manager

= Workload Simulator

= 2/0OS Problem Determination and Deployment Tools Can Be
Ordered From Your IBM z/Series Sales Representative

|DEMAND BUSINESS
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IBM PD Tools Product Identification

= Fault Analyzer for z/OS (5655-S15)
= File Manager for z/OS (5655-S14)
= Debug Tool Utilities and Advanced Functions for z/OS (5655-S16)

= Application Performance Analyzer for z/OS (5697-N63)

" ﬁ%pgg:ation Performance Analyzer Automation Assistant for z/OS (5799-

= Workload Simulator for z/OS & OS/390 (5655-139)
= Rational Functional Tester (5726-J07)

= Rational Performance Tester for z/OS (5724-J96)
= Migration Utility (5697-N44)

= Application Time Facility (5697-N42)

= |SPF Productivity Tool (5698-A81)

= File Export Utility (5697-112)

= Rational Developer for System z

MAND BUSINESS
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CICS VSAM Recovery

Risk Management for Your Mission Critical VSAM Data
George Lees

'ON DEMAND BUSINESS

© 2007 IBM Corporation
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CICS VSAM Recovery

= What does it do?
» Recovers lost or damaged VSAM data
» Recovers updates made to data by CICS and/or batch applications
» Provides assistance and processes for VSAM Disaster Recovery

» Automates VSAM backup and restore processes
» Provides intelligent decision automation for certain VSAM error conditions
» Fully supports log records written by Transactional VSAM (DFSMStvs)

Benefits

» Automates recovery for physically or logically damaged or lost VSAM files
» Quickens recovery from batch window errors

» Reduces overall VSAM recovery time

» Provides database type recovery for your VSAM files

MAND BUSINESS
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CICS VSAM Recovery for z/OS (CICS VR)

=Key features
» Automated recovery
» Extensive functionality and authorization
management the from ISPF panel interface
» Provide test-only forward recovery and backout
» Disaster recovery report
» Export and Import commands
» Change accumulation
» Batch support including logging
» NOTIFY support for IBM and non-IBM backups

=CICS Support
» CICS Transaction Server for z/OS, V2 and V3
» CICS Transaction Server for OS/390 V1.3

New in CICS VR V4.2
*CICS TS V3.2 support

*Extended addressability Entry
Sequenced Data Sets (ESDSs)

*Backout failure detection operates
in a thread-safe mode

Integration with external backup
products, including IBM ABARS

Enhanced logging support

Coming Soon

*Additional functionally for the ISPF
dialog

-Automation enhancements

«Extend support for non IBM backups

MAND BUSINESS
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Architecture
Batch -
— V
J Ob Add P MVS ) FORWAR%F:SS“XERY LOG N
Space SYSTEM Copies of FORWARD .
LOGGER RECOVERY LOG STREAMS [ .
VR Glue
> C I CS — LOG OF LOGS >
) CICS LOG
MANAGER
DOMAIN
!
VR Addr
Space
ISPF
Interface
Restored
Recovery Files
Job

MAND BUSINESS
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CICS VR — Business Value

Insurance protection for your mission critical VSAM files

Use familiar database recovery techniques reducing the learning
curve for implementation

Provide consistency for all VSAM processing types

Reduce cost of operator intervention and on call support with
automation of VSAM file error detection

» Detect VSAM errors and take corrective action

Potential savings in the batch cycle by reducing number of
backups

Assistance at Disaster Recovery with exported RCDS and quicker
automated recovery

Reduce human errors with automated recovery processes

MAND BUSINESS
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CICSVR and Disaster recovery

= CICSVR disaster recovery utilities

» Log stream copy
= Create sequential data set copy of a forward recovery log stream
» RCDS import/export

= Create sequential data set that contains essential recovery
information

— Includes information related to logstreams, backups and change
accumulation data sets

» Remote site change accumulation

= Create change accumulation data sets for use at a remote
recovery site

= Will accumulate latest unread portion of forward recovery log
stream

» Shadow recovery

= Maintain updated copies of VSAM spheres at a remote recovery
site

MAND BUSINESS
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CICSVR Summary

= CICS VR is your insurance policy for your Corporate VSAM data

» Data can be lost through operational error, hardware or software failure
or total disaster

Helps automate recovery in the following scenarios
» Recover physically damaged or lost VSAM files at the primary site
» Recover VSAM files in a disaster recovery scenario (at a remote site)
» “Logically” recover VSAM files from particular updates
» Remove updates made by failed batch jobs steps

Helps quicken recovery from batch window errors

Reduces recovery time

Recovers from updates made by CICS, batch, or both
Supports CICS TS, Version 3, Version 2, and 1.3

MAND BUSINESS
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CICS VSAM Transparency

Exploit the Value of Your Business Data that Resides on
VSAM

'ON DEMAND BUSINESS

© 2007 IBM Corporation
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CICS VSAM Transparency

= What does it do?

» Move your data from VSAM to DB2 without application program
changes

» Clean data via utilities to eliminate bad data “surprises”
» Re-engineer data to increase corporate value

= Benefits
» Low Risk migration strategy
» Modify application programs at a controlled pace

» Can help lower the total cost of ownership of your zSeries
platform

DEMAND BUSINESS'
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CICS VSAM Transparency

Tool to migrate VSAM files to DB2 without changing applications
programs

» Single Instance of the data is maintained!!

Both CICS and Batch programs can access data in DB2 under the
control of CICS VT

Migrated data can be accessed via SQL by new programs

Low risk migration strategy

» Fast path to move VSAM data to DB2

» Not all VSAM files need to be migrated

» Modify application programs at a controlled pace

DEMAND BUSINESS'
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CICS VT Capabilities

= Completely separate from application program

= Transparent access to data in DB2

100% static SQL

= Migrate on a file by file basis

Data can be re-engineered
» Same data returned to VSAM programs
» Enhanced data available using SQL

MAND BUSINESS
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WHAT EXACTLY IS CICS VT?

After CICS VT

Application
-, Iy o —

O

-

=] =

=S>0n<

DB2
Table #1
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CICS VSAM Transparency for z/OS (CICS VT)

=Key features

» Migrate VSAM files to DB2
= without changing application programs

= single copy of the data

» CICS programs access data via GLUE/TRUE

aCccCess

» Batch programs access DB2 via CICS VT
» Cleansing migration utilities

» Add SQL to existing programs

» No additional region / STC required

CICS Support

» CICS Transaction Server for z/OS, V2 and V3
» CICS Transaction Server for OS/390 V1.3

New in CICS VT V1.2

CICS TS V3.2 support without
modification

CICS TS V3.2 threadsafe File
Control API performance
benefits

Dual Mode Facility assists with
testing of migrated data

Automated Mapping Facility
now supports PL/l and
Assembler

Re-entrant SQL driver modules

MAND BUSINESS
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For more information

Tools WEB sites Program numbers
» CICS tools, including library: www.bm.com/cics/lools  555-P30: CICS VSAM Recovery

5697-176: CICS VSAM Transparency

» WebSphere zSeries tools:
www.ibm.com/software/websphere/zadportal

» Try CICS tools for free for 60 days

www.ibm.com/software/os/zseries/trials/cicstools

I_UN DEMAND BUSINESS
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Polling Questions

ON DEMAND BUSINESS
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Question and Answer

MAND BUSINESS
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Thank You for Joining Us today!

Go to www.ibm.com/software/systemz to:
» Replay this teleconference
» Replay previously broadcast teleconferences

» Register for upcoming events

'ON DEMAND BUSINESS



